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PDF books and the information center

PDF books are provided as a convenience for printing and offline reading. For the latest information, see
the online information center.

As a set, the PDF books contain the same content as the information center. Some links within the PDF
books have been tailored for use in the information centers and may not work properly.

The PDF documentation is available within a quarter after a major release of the information center, such
as Version 7.0 or Version 7.5.

The PDF documentation is updated less frequently than the information center, but more frequently than
the Redbooks®. In general, PDF books are updated when enough changes are accumulated for the book.

© Copyright IBM Corp. 2005, 2011 iii



iv Installing



Contents

PDF books and the information center iii

Installing and configuring IBM Business
Process Manager for Microsoft Office
Add-On . . . . . . . . . . . . . . . 1
Software and hardware requirements for installing
IBM BPM for Microsoft Office . . . . . . . . 1
Upgrading to IBM Business Process Manager for
Microsoft Office Add-On 7.5 . . . . . . . . . 2

Upgrading from Teamworks for Office 2007 or
Lombardi for Office 7.2 . . . . . . . . . . 2
Upgrading from Teamworks for Office 2003 . . . 2

Installing IBM BPM for Microsoft Office . . . . . 4
Running the IBM BPM for Microsoft Office
installer . . . . . . . . . . . . . . . 4

Running the silent installer . . . . . . . . 4
Installing IBM BPM for Microsoft Office using
Microsoft Systems Management Server . . . . 5
Configuring single sign-on authentication with
IBM Process Server . . . . . . . . . . . 7
IBM BPM for Microsoft Office directories and files
installed on the client . . . . . . . . . . 7

Configuring IBM BPM for Microsoft Office . . . . 7
Setting up IBM BPM for Microsoft Office in
Microsoft Outlook . . . . . . . . . . . 7
Configuring integrated authentication in IBM BPM
for Microsoft Office . . . . . . . . . . . 8

Removing the product . . . . . . . . . . . 9
Troubleshooting . . . . . . . . . . . . . 9

© Copyright IBM Corp. 2005, 2011 v



vi Installing



Installing and configuring IBM Business Process Manager for
Microsoft Office Add-On

IBM Business Process Manager for Microsoft Office Add-On is an integrated add-on for Microsoft
Outlook in Microsoft Office. The installing and configuring topics help you install, configure, and
troubleshoot IBM BPM for Microsoft Office.

Software and hardware requirements for installing IBM BPM for
Microsoft Office
Make sure that your system meets the software and hardware requirements before installing IBM
Business Process Manager for Microsoft Office Add-On.

Software requirements

The following table describes the software requirements for IBM BPM for Microsoft Office. In addition to
the software requirements listed here, IBM® Business Process Manager V7.5 (Standard, Advanced, or
Express) is required.

Table 1. Software requirements for installing IBM Business Process Manager for Microsoft Office Add-On

Component type Component name

Operating systems

v Microsoft Windows® Server 2008 (32-bit and 64-bit)

v Microsoft Windows® 7 (32-bit and 64-bit)

v Microsoft Windows XP Professional SP2

v Microsoft Windows Vista (32-bit and 64-bit)

Client - Microsoft Office 2010 v Microsoft Office 2010

v Visual Studio Tools for the Microsoft Office system 4.0
Runtime

Download website

v Microsoft .NET 4.0

Download website

Client - Microsoft Office 2007 v Microsoft Office 2007

v 2007 Microsoft Office Primary Interop Assemblies,
version 1.0

Download website

v Visual Studio Tools for the Microsoft Office system 3.0
Runtime, version 9.0.21022.123

Download website

v Microsoft .NET 3.5 Service Pack 1

Download website

Hardware requirements

The following hardware sizing suggestion is the minimum hardware required for running IBM BPM for
Microsoft Office. The IBM Professional Services team can help you size your hardware based on more
precise numbers of users, transactions, and data.
v
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Intel® Pentium® 4, 2.0 GHz processor
v

512 MB RAM
v

About 250 MB of free disk space for the application

Upgrading to IBM Business Process Manager for Microsoft Office
Add-On 7.5
If you have previously installed Lombardi for Office 2003, Teamworks for Office 2003Teamworks for
Office 2007, or IBM WebSphere Lombardi Edition for Office 7.2, follow these instructions to upgrade to
IBM Business Process Manager for Microsoft Office Add-On.

Upgrading from Teamworks for Office 2007 or Lombardi for Office 7.2
You can upgrade from Teamworks for Office 2007 or Lombardi for Office 7.2 to IBM Business Process
Manager for Microsoft Office Add-On.

Note: IBM BPM for Microsoft Office requires IBM Business Process Manager 7.5 (any edition). IBM BPM
for Microsoft Office is not supported with IBM WebSphere Lombardi Edition for Office 7.2.

If you have previously installed Teamworks for Office 2007 or Lombardi for Office 7.2, and you are
upgrading to IBM BPM for Microsoft Office, follow these upgrade steps.

If you have previously installed Lombardi for Office 2003, follow instructions in “Upgrading from
Teamworks for Office 2003.”
1. There are two methods for upgrading to IBM BPM for Microsoft Office: Interactive removal and

installation, or silent removal and installation.
v Interactive installation method: Double-click the IBM-BPM-for-Office-Installer.exe installer

program file and follow the instruction to first uninstall a previous version and then install the
latest version.

v Silent installation method:
a. Remove Teamworks for Office 2007 or Lombardi for Office 7.2 using the following command:

msiexec /uninstall IBM-BPM-for-Office-Installer.msi /qn REMOVE=ALL

b. Install IBM BPM for Microsoft Office using the instructions provided in the section “Running
the silent installer” on page 4.

2. Start Microsoft Outlook.

If the upgrade is successful, an IBM Business Process Manager directory is created at the same
hierarchical level as the Mailbox folder.

Note: By default, the IBM BPM for Microsoft Office installation sets the authentication mode to
Integrated Authentication. If you are updating your installation, verify that the authentication setting is
correct in your Microsoft Outlook client. For more information, see “Configuring integrated
authentication in IBM BPM for Microsoft Office” on page 8.

Upgrading from Teamworks for Office 2003
You can upgrade from Lombardi for Office 2003 or Teamworks for Office 2003 to IBM Business Process
Manager for Microsoft Office Add-On.

Before you begin the upgrade:
v Uninstall Lombardi for Office 2003 or Teamworks for Office 2003 before upgrading to Microsoft Office

2007 or Microsoft Office 2010.
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v Make sure you have the correct version of IBM Business Process Manager installed. IBM BPM for
Microsoft Office requires IBM Business Process Manager V7.5 or later. IBM BPM for Microsoft Office is
not supported with IBM WebSphere Lombardi Edition for Microsoft Office Add-on 7.2 or previous
versions.

v Ensure that there are no forms or tasks in the Drafts (if online) or Outbox (if offline) folders in
Microsoft Outlook 2003 before upgrading to Microsoft Office 2007 or Office 2010. You must submit any
pending forms before performing the upgrade steps. The offline Outbox folder is not part of IBM BPM
for Microsoft Office and therefore the contents of this folder will no longer be accessible after the
upgrade.

If you have previously installed Teamworks for Office 2003, and you are upgrading to IBM BPM for
Microsoft Office V7.5, follow these upgrade instructions.
1. Uninstall your previous version of the product. There are two methods for upgrading to IBM BPM for

Microsoft Office: Interactive removal and installation, or silent removal and installation.
v Interactive installation method:

a. If necessary, upgrade Microsoft Office 2003 to Microsoft Office 2007 or Office 2010 before
upgrading to IBM BPM for Microsoft Office.

Note: Do not uninstall Microsoft Office 2003 Primary Interop Assemblies (PIA) until the IBM
BPM for Microsoft Office upgrade is complete.

b. Make sure all the IBM BPM for Microsoft Office software prerequisites are installed. For more
information, see “Software and hardware requirements for installing IBM BPM for Microsoft
Office” on page 1.

c. Double-click the IBM-BPM-for-Office-Installer.exe installer program file.
d. The installer program prompts you to remove any earlier versions of the product that it finds

on the client. The installer program then installs IBM BPM for Microsoft Office on your system.
v Silent installation method:

a. Remove the earlier version by running one of the following commands, depending on which
version is installed on your system.
Teamworks for Office 2003 2.0 SP1:
msiexec /uninstall IBM-BPM-for-Office-Installer.msi /qn REMOVE=ALL

Teamworks for Office 2003 2.0:
msiexec /uninstall IBM-BPM-for-Office-Installer.msi /qn REMOVE=ALL

For Lombardi for Office 2003, silent removal using a command is not supported. Instead, click
Start > All Programs > Lombardi for Office > Uninstall Lombardi for Office 2003. The
uninstaller wizard opens.

b. Rename the IBM BPM for Microsoft Office settings file. For example, rename C:\Documents
and Settings\<user name>\Application Data\Lombardi\settings.xml to C:\Documents and
Settings\<user name>\Application Data\Lombardi\settings_2003.xml. This step creates a
backup copy of the settings file. The settings used for Teamworks for Office 2003 are not valid
for IBM BPM for Microsoft Office.

c. Install IBM BPM for Microsoft Office using the instructions provided in the section “Running
the IBM BPM for Microsoft Office installer” on page 4.

2. Start Microsoft Outlook.

If the upgrade is successful, an IBM BPM for Office directory is created at the same hierarchical level as
the Mailbox folder.

Note: By default, the IBM BPM for Microsoft Office installation sets the authentication mode to
Integrated Authentication. If you are updating your installation, be sure to verify that the authentication
setting is correct in your Microsoft Outlook client. For more information, see “Setting up IBM BPM for
Microsoft Office in Microsoft Outlook” on page 7.
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Installing IBM BPM for Microsoft Office
There are two ways to install IBM Business Process Manager for Microsoft Office Add-On. You can install
by running the IBM BPM for Microsoft Office installer program, or use Microsoft Systems Management
Server (SMS) to deploy to large installation bases.

Before installing IBM BPM for Microsoft Office, review the release notes for important, late-breaking
information.

Running the IBM BPM for Microsoft Office installer
Install IBM Business Process Manager for Microsoft Office Add-On using the installer program.

Before installing IBM BPM for Microsoft Office, make sure that your system meets these requirements:
v Microsoft Office 2007 or Microsoft Office 2010 is installed.
v All of the components listed in the Software requirements topic are installed.

Note: The IBM Business Process Manager for Microsoft Office Add-On installer does not install the
Office 2007 Primary Interop Assemblies or VSTO 3.0 Runtime prerequisites. You must install these
programs yourself before running the IBM BPM for Microsoft Office installer. See “Software and
hardware requirements for installing IBM BPM for Microsoft Office” on page 1.

v You must have Administrator privileges or Domain Administrator privileges to run the
IBM-BPM-for-Office-Installer.exe file.

v Optional: If you want to use single sign-on (SSO) to log on to IBM Business Process Manager, follow
the administrative steps required to set up SSO for your IBM Business Process Manager system before
installing IBM BPM for Microsoft Office.

IBM Business Process Manager supports Kerberos-based automatic login (often referred to as single
signon). This functionality reduces configuration overhead and simplifies the authentication process by
using the credentials of the current Windows user to authenticate with IBM Business Process Manager.
The Kerberos protocol enables IBM Business Process Manager users to automatically log on to IBM
Process Portal, IBM Process Admin Console, IBM Process Center Console, IBM BPM for Microsoft Office,
and IBM BPM for Microsoft SharePoint. For more information, see “Configuring single sign-on
authentication with IBM Process Server” on page 7. For help with implementing single signon for IBM
BPM for Microsoft Office, contact IBM customer support.
1. To run the IBM BPM for Microsoft Office installer, double-click the IBM-BPM-for-Office-Installer.exe

file and then enter the appropriate information by responding to the prompts.
2. The default installation directory is C:\Program Files\IBM\Business Process Manager for Office\.

You can click Change to specify a different directory.
3. Click Finish to complete the installation.

Running the silent installer
You can install IBM Business Process Manager for Microsoft Office Add-On silently using a command.

Before running the silent installer, make sure that your system meets these requirements:
v Previous versions of the product have been removed. For more information, see “Removing the

product” on page 9. Specific instructions for removing Teamworks for Office 2003 are provided in
Upgrading from Teamworks for Office 2003, in the silent installation steps.

v Prerequisite client software is installed. The installer program prompts you for the prerequisite
software if it is not found on the client system. For more information, see section Software requirements
for IBM BPM for Microsoft Office.

v Access permissions are correct. You must have Administrator privileges or Domain Administrator
privileges to run the IBM-BPM-for-Office-Installer.msi file.
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v You have read and agree with the IBM BPM for Microsoft Office and client software licenses. For more
information, see “Software and hardware requirements for installing IBM BPM for Microsoft Office” on
page 1.

From a command line, follow these steps to silently install IBM BPM for Microsoft Office.
1. Run the IBM-BPM-for-Office-Installer.msi file to install IBM BPM for Microsoft Office on the

network of clients. The IBM-BPM-for-Office-Installer.msi file enables you to run the installer
program silently from a command line. You must add the /quiet argument to the installer command
for silent installation, as shown in the example.
"IBM-BPM-for-Office-Installer.msi" /quiet

You can also generate an installation log file by adding the /L* parameter and a file name at the end
of the command, as shown in this example:
"IBM-BPM-for-Office-Installer.msi" /quiet /L* installLog.txt

2. You can install silently using the msiexec syntax, as shown in the example.
msiexec /package|"IBM-BPM-for-Office-Installer.msi" /qn /L* installLog.txt

3. Optional: Configure the installation silently. You can configure the installation silently, or leave the
configuration up to each client user to perform in Microsoft Outlook. For more information, see the
section Setting up IBM BPM for Microsoft Office in Microsoft Outlook. To configure the installation
silently, pass the command arguments for configuring the client installation to the MSI file. Use the
following command arguments to perform the silent configuration:
v LSWSERVER: This is the address of the IBM Process Server. The valid syntax for this property is

http://servername:port.
v LSWUSER: Specifies the IBM Business Process Manager user name. This argument is not necessary

if you are using integrated authentication, which is the default authentication mode.
v LSWSAVEDSEARCHES: This argument must include a comma-delimited list of saved searches to

synchronize. Supply the numeric ID of each saved search, for example: 1 for Inbox, 2 for History, 3
for Help Requests, or 4 for Alerts.

v LSWAUTHTYPE: This argument specifies the authentication mode, which can be basic or
integrated. The default mode is integrated authentication.

When performing a silent configuration, you must add the /quiet argument to the MSI command, as
shown in the following example.
"IBM-BPM-for-Office-Installer.msi" /quiet LSWSERVER=http://myserver:8081 LSWUSER=tw_admin LSWSAVEDSEARCHES=1,2,3 LSWAUTHTYPE=basic

Installing IBM BPM for Microsoft Office using Microsoft Systems
Management Server
You can install IBM Business Process Manager for Microsoft Office Add-On using Microsoft Systems
Management Server (SMS).

This installation method is ideal in environments that require multiple installations of IBM BPM for
Microsoft Office across a network of clients. The following steps show how to configure SMS for
deployment to a group of users. The example assumes that the SMS site server is also the distribution
point, and that all the client systems where IBM BPM for Microsoft Office is installed are assigned to a
single SMS site server. These steps illustrate an installation procedure that requires no client interaction.

Before installing IBM BPM for Microsoft Office, make sure that the prerequisite client software is
installed. The installer program fails and displays an error message if the prerequisite client software is
not found during installation. For more information, see “Software and hardware requirements for
installing IBM BPM for Microsoft Office” on page 1.
1. Start the SMS Administrator Console.
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2. Create an SMS collection that includes all the users or client systems to which you are installing IBM
BPM for Microsoft Office. For example, the collection might include All Users, or All Windows XP
Professional Systems.

3. Enable IBM Business Process Manager folder home pages using a group policy. In Microsoft Office
Outlook, the home page setting is disabled for non-default stores. Therefore, by default the IBM BPM
for Microsoft Office Today and My Tasks views are disabled. To enable the views, apply a group
policy by following the instructions provided under Resolution: Method 1 in the Microsoft Support
knowledge article.

4. Copy the IBM-BPM-for-Office-Installer.msi file to a local directory on the SMS server.
5. Create an SMS Package for the IBM BPM for Microsoft Office installation.

a. You can create a package in the SMS Administrator console by clicking Packages , then selecting
New > Package .

b. In the Package Properties window, click the General tab, and enter the package values.
c. In the Data Source tab, select This package contains source files.
d. Under Source directory , click Set .
e. In the Set Source Directory window, select Local drive on the site server.
f. Navigate to the directory that contains the MSI file, and set the directory as the Source Directory

for the package.
6. Add a distribution point to the package. For example, the distribution point can be the local SMS site

server.
a. Edit the Program Properties to add the program to the SMS package.
b. In the Program Properties window, click the General tab, then enter the appropriate installation

command. For example:
"IBM-BPM-for-Office-Installer.msi" /quiet LSWSERVER=http://myserver:8081 LSWUSER=tw_admin LSWSAVEDSEARCHES=1,2,3 LSWAUTHTYPE=basic

c. Add the program requirements. For more information about program requirements for IBM BPM
for Microsoft Office, see “Software and hardware requirements for installing IBM BPM for
Microsoft Office” on page 1.

d. Click on the Environment tab, then set the Run Mode to Run with administrative rights . Make
sure that the option Allow users to interact with this program is not selected.

e. Click on the Advanced tab, then select Run once for the computer.
7. Distribute IBM BPM for Microsoft Office software to the client systems.

a. Right-click on the collection name that you created previously. This collection must include all
users or client systems where you want to install IBM BPM for Microsoft Office.

b. Click All Tasks > Distribute Software to Clients.
c. Select your Package.
d. Select your Distribution Point.
e. Select your Program.
f. Select Create a New Advertisement, and set the advertisement schedule.
g. Select Assign the Program, and set the assignment time.

8. On the client system, when the assignment time arrives, the IBM BPM for Microsoft Office installation
is launched.
a. A message is displayed with the following text:

Assigned Program About to Run An assigned program will run in 5 minutes Double-click here for more information . . .

b. You can see detailed information about the installation by double-clicking in the message. For
example:
Program Countdown Status <name of the installation package> This program will begin running in 1 minute 42 seconds If you are ready to run this program now, click Run

c. When the countdown ends, the installation begins.
d. When the installation is complete, restart Microsoft Outlook.
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Configuring single sign-on authentication with IBM Process Server
To enable IBM Business Process Manager for Microsoft Office Add-On to communicate with IBM
Business Process Manager using single signon (SSO), you must configure IBM Process Server to accept
plain-text logon credentials from IBM BPM for Microsoft Office.
1. Open the PROFILE_HOME\config\cells\cell_name\nodes\node_name\servers\server_name\

server_type\config\100Custom.xml file, where server_type is either process-server or process-center,
depending on your server type.

2. Add the following code block within the <properties> element:
<properties> . . . <authoring-environment merge="mergeChildren"> <add-redirect-url-credentials merge="replace">true</add-redirect-url-credentials> <encode-redirect-url-

3. Save your changes.
4. Restart IBM Process Server.

IBM BPM for Microsoft Office directories and files installed on the
client
When you install IBM Business Process Manager for Microsoft Office Add-On, a IBM BPM for Microsoft
Office folder is created as a peer folder to the Mailbox folder in Microsoft Outlook. This folder contains
your IBM BPM for Microsoft Office tasks and saved searches.

Additionally, a directory containing IBM Business Process Manager information is saved locally for offline
viewing on the client system. This directory includes the TfoData.pst file, which is required for IBM BPM
for Microsoft Office to run properly.

The location of the IBM BPM for Microsoft Office directory is:
v C:\Documents and Settings\[user_name]\Application Data\Lombardi\Office\ on Microsoft

Windows® XP Professional.
v C:\Users\[user_name]\AppData\Roaming\Lombardi\Office\ on Microsoft Windows Vista and

Microsoft Windows 7.

The IBM BPM for Microsoft Office TfoData.pst file is different from your personal email PST file, and it
resides in a different location in the file system. Only data from IBM BPM for Microsoft Office is included
in the TfoData.pst file, so the file does not affect your personal email settings.

Configuring IBM BPM for Microsoft Office
After you have successfully installed IBM BPM for Microsoft Office, configure Microsoft® Outlook and
IBM BPM for Microsoft Office.

Setting up IBM BPM for Microsoft Office in Microsoft Outlook
After you have successfully installed IBM Business Process Manager for Microsoft Office Add-On, when
you start Microsoft Outlook for the first time, you must configure Microsoft Outlook so that IBM BPM for
Microsoft Office can run properly.
1. Start Microsoft Outlook.
2. When prompted, accept the certificate to complete the installation of IBM BPM for Microsoft Office.
3. In the Configure Server window, select the Authentication mode. You can select Basic authentication

or Integrated authentication. Integrated authentication is the default authentication mode.
4. Type the server address, including the port where IBM Process Server runs.
5. >If you are using basic authentication mode, enter your username and password. You can test your

connection to the server by clicking Test . If the connection is successful, a Test Passed message is
displayed in the Configure Server window.
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Note: The Username and Password fields are disabled when integrated authentication mode is
selected. For more information about integrated authentication mode, see “Configuring integrated
authentication in IBM BPM for Microsoft Office.” You can change the authentication mode using the
Configure Server window. Click File > Options > Add-ins > Add-in options , then click the IBM
Business Process Manager tab.

6. Configure the IBM BPM for Microsoft Office saved searches options.
a. In the Configure Server window, click Saved Searches.

You can view Inbox items, Alerts, History, and Help Requests using the default saved searches. To
change the saved searches that are displayed in Microsoft Outlook, click to select additional
searches, or to clear the default searches. The saved search results are displayed on the My Tasks
page.

b. To enable task synchronization, click the options under Saved Search Task Synchronization.
After you have established a connection to the IBM Process Server, in a runtime environment, you
can synchronize saved search tasks by clicking Synchronize on the IBM Business Process Manager
toolbar in Microsoft Outlook. If the Toolbar button synchronizes tasks option is selected,
Microsoft Outlook downloads your tasks when you click Synchronize. When the Schedule an
automatic sync every X minutes option is selected, Microsoft Outlook downloads your tasks at
the specified polling interval. The interval is specified in minutes.

7. Click OK when you are finished with the configuration changes.
8. After you have established a connection to the specified IBM Process Server in the runtime

environment, synchronize data by clicking Synchronize on the IBM Business Process Manager toolbar.
9. Click IBM Business Process Manager on the toolbar. The IBM BPM for Microsoft Office Today page

opens, displaying the latest information about your processes.

If you want to change the configuration settings after running Microsoft Outlook, click Tools > Options,
and then click theIBM BPM for Microsoft Office tab.

Configuring integrated authentication in IBM BPM for Microsoft Office
The integrated authentication between Microsoft® Windows® and IBM Business Process Manager for
Microsoft Office Add-On allows you to access the IBM BPM for Microsoft Office client more efficiently.

IBM Business Process Manager supports Kerberos-based automatic logon. This authentication mode is
also referred to as single sign-on (SSO). This functionality reduces configuration overhead and simplifies
the authentication process by using the credentials of the current Windows user to authenticate with IBM
Business Process Manager. The Kerberos protocol allows IBM Business Process Manager users to
automatically log on to IBM Process Portal Console, IBM Process Admin Console, IBM BPM for Microsoft
Office, and IBM BPM for Microsoft SharePoint.

When single sign-on is implemented, you no longer need to configure a username and password in IBM
BPM for Microsoft Office. Instead, IBM BPM for Microsoft Office authenticates using your Windows
credentials. IBM BPM for Microsoft Office supports integrated authentication by default.

To change the authentication setting, follow these steps.
1. In Microsoft Outlook, click Tools > Options > Add-ins > Add-in options.
2. In the Options window, click the IBM BPM for Microsoft Office tab.
3. Select Integrated or Basic from the Authentication menu.

For help with implementing single sign-on for IBM BPM for Microsoft Office, contact IBM customer
support.
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Removing the product
To remove IBM Business Process Manager for Microsoft Office Add-On from your system, run the IBM
BPM for Microsoft Office uninstaller program, then follow the instructions provided by the program. You
can also uninstall silently using a command.

A short cut to the uninstall program is provided in the Windows® Start Programs menu. Click Start > All
Programs > IBM BPM for Microsoft Office Add-On > Uninstall IBM BPM for Microsoft Office.

To uninstall silently, run the following command:
msiexec /uninstall "IBM-BPM-for-Office-Installer.msi" /qn REMOVE=ALL

Troubleshooting
Review the troubleshooting issues to diagnose and fix common problems.

Because the configuration of your particular environment might differ from the standard configuration,
you might see some of the following common issues when you are installing or updating the product.
Make sure that you also search release notes items in the IBM Business Process Manager support portal
for late-breaking information.

Configuring the location of the tfo.log file

A log file containing information about installation and application operation is useful for
troubleshooting. To enable IBM BPM for Microsoft Office to create the log file tfo.log , you must edit the
logconfig.xml file and enter a valid directory path as the value of the <file> property. For example:
<file value="c:\tfo.log"/>

The IBM BPM for Microsoft Office installer program creates the log configuration file logconfig.xml in
the following location:

C:\Documents and Settings\Administrator\Application Data\IBM\Business Process Manager Office\
for Microsoft® Windows® XP Professional.

C:\Users\<user_name>\AppData\Roaming\IBM\Business Process Manager for Office\ for Microsoft
Vista, Microsoft Windows® 7, and Microsoft Windows 2008.

Saving Inbox items to disk does not work in IBM BPM for Microsoft Office

In Microsoft Outlook, you can save a message to disk (for example, by dragging it to the desktop) and
then view the message offline as a fully functional Outlook message in other Microsoft Office
applications. Although IBM BPM for Microsoft Office appears to provide the same function for task items
in the IBM Business Process Manager Inbox, the saved *.msg item does not work because the offline
viewing function is not supported in IBM BPM for Microsoft Office.
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